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INTRODUCTION
Apple Final Cut Pro is a tool we use to tell stories with moving pictures. But owning a tool 
is not the same as knowing how to use that tool. Video editing is the last step in the long 
process of visual story creation—the last step before sharing that story with an audience. 
Deadlines are short, budgets are tight, and everyone is stressed. Anything that saves time, 
simplifies a process, or improves results is a good thing. 

That’s what this book is about. These 500+ tips, techniques, shortcuts, and hidden gems that 
will turn you into an editing powerhouse. This book can’t teach you how to edit, but it can 
teach you how to edit more effectively. 

I’ve worked in media as an on-camera host, producer, director, and editor for more than 
50 years. Over that time, I’ve learned that one of the worst mistakes an editor can make is to 
do something “because you can.” Technical ability is never a good reason to do anything. 
Instead, focus your editing on the story you are telling. Then, you’ll find yourself doing some-
thing “because you should.” Because it benefits the story. Because it enables understanding. 
Because it improves communication.

I have used, studied, taught, and written about Final Cut Pro since 2003; almost 20 years. 
This book is a collection of the best of what I’ve learned. During that time, much of our 
industry has changed, yet much also remains the same. Like all creative arts, editing has 
styles. Not just styles in genre but styles in clip duration, transitions, titles, effects, color 
grading…the list is lengthy. Some styles are worth keeping, others not so much. 

This book isn’t a textbook. I don’t cover all the features in Final Cut. This is a book for some-
one with a specific question who needs an accurate answer right now. I take you deep into 
the application to tap the hidden power of the program.

The printed version of this book is organized into nine chapters, plus an online chapter, 
each grouped by subject. (The digital version contains all ten chapters.) Within each chapter, 
related tips are gathered into sections so you can quickly skim to find the information you 
need. You can dip into a single tip for a fast answer or read an entire chapter to further your 
understanding.

One other thing I need to mention. In today’s highly monetized, advertising-driven world, no 
one paid me to mention any products in this book. All my recommendations are tools that I 
purchased and use every day in my own projects.

I used Apple Final Cut Pro 10.6.3 for all screen shots and tips. If I forgot your favorite or 
there’s a mistake, send me an email and let me know. We will fix it in the next edition. In the 
meantime, edit well.

Larry Jordan 
Andover, MA 

July 2022 
Larry@LarryJordan.com
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BASIC EDITING
CHAPTER 4

INTRODUCTION
Editing is where the spark of creativity first lights. Editing decides which 
portion of each clip to show and where it goes in the timeline. Trimming 
adjusts where two clips touch, called the edit point. Trimming is critically 
important to storytelling because it adjusts how smoothly one shot flows 
into the next. Often, you’ll spend more time trimming than editing, even 
for simple projects.

In this chapter, we—finally!—move into actual editing. There’s so much to 
cover that we’ll divide editing and trimming into two parts: basic tech-
niques in this chapter and advanced techniques in the next.

	● Mark Clips
	● Edit Clips
	● Editing Tools

	● Trim Clips
	● Timeline Index
	● Shortcuts
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DEFINITIONS FOR THIS CHAPTER
	● Editing. Editing decides what clips to use, their order, and duration.
	● Trimming. Trimming adjusts where two clips touch.
	● Through edit. This is a cut (edit) in a clip where nothing was removed 

on either side. 
	● Camera. The camera represents the eye of the audience. Every time 

you change the shot, you move the audience to a new place. Treat the 
audience gently, and be careful not to disorient them.

	● Primary Storyline (aka magnetic timeline). This is the black bar in the 
middle of the timeline. Designed for speed and to minimize errors, it’s 
where you put the principal clip for each scene.

	● Layer. Other NLEs call these tracks. Apple prefers the term layers. 
Layers are horizonal levels that hold clips above or below the Primary 
Storyline. There is no limit to the number of layers in Final Cut.

	● Connected clip. This is a clip on a higher (or lower) layer that 
“connects to” a clip on the Primary Storyline. Connected video clips go 
above the Primary Storyline, while connected audio clips go below it. 
Connected clips are always rendered to match the project settings.

	● Storyline. This is a group of connected clips on a higher (or lower) 
layer that are treated as a single clip. It can hold audio or video but 
can’t contain clips on multiple layers. 

	● B-roll. This is an old film term describing video clips placed on a higher 
layer to illustrate what the clip in the Primary Storyline is discussing. 

	● Downstream (upstream): Timelines are often described as water  
flowing from the beginning (left) to the end (right). Downstream refers 
to all clips from the playhead (skimmer) to the right. Upstream refers to 
all clips from the playhead (skimmer) to the left.

	● Snapping. When enabled, this option snaps the playhead (or skimmer) 
to edit points and markers. When snapped to an edit point, the play-
head (skimmer) is always parked on the In.

	● In. This is where the playback of a clip starts, which is most often not 
the start of the clip.

	● Out. This is where the playback of a clip ends, which is most often not 
the end of the clip.

	● Range. This is the part of a clip, or timeline, defined by an In and 
an Out.

	● Handles. This is extra audio and video before the In and/or after the 
Out used for trimming and transitions.

Editing decides 
clip order and 
duration. Trimming 
adjusts where two 
clips touch.
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	● Edit point. This is where two clips touch in the timeline. An edit point 
has three “sides” or edges: the In, the Out, and both the In and the Out.

	● Ripple trim. This adjusts one side of an edit point, the In or the Out. 
Ripple trims always alter the duration of a project.

	● Roll trim. This adjusts both sides of an edit point at the same time. 
Roll trims never alter the duration of a project.

	● Timeline element. This is shorthand for things in the timeline: clips, 
titles, generators.

MARK CLIPS
Marking clips begins the editing process. This determines the start and end 
of each clip when edited into the timeline.

	 Playback Shortcuts
There are a variety of ways to play clips.

The easiest way to play any clip is to press the spacebar.

	● Shift-spacebar. Plays a clip in reverse.
	● J. Plays a clip in reverse.
	● J-J. Plays a clip in reverse at double-speed.
	● J-J-J. Plays a clip in reverse at 4X speed.
	● L. Plays a clip forward.
	● L-L. Plays a clip forward at double-speed.
	● L-L-L. Plays a clip forward at 4X speed.
	● J-K. Plays a clip in reverse in slow motion.
	● L-K. Plays a clip forward in slow motion.

Here are more playback shortcuts that work in the timeline:

	● /. Plays the selection.
	● Shift+?. Using the durations set in Preferences > Playback, shifts the 

playhead from its current location back to the pre-roll duration, plays 
through the edit, then stops at the end of the post-roll duration. It 
then returns the playhead to its original position. This is often used to 
review continuity through an edit point.

	● Shift+Option+I. Plays from the beginning of the Browser clip or time-
line to the end.

192

Skim clips with the 
mouse, trackpad, 
or trackball, 
as well as play 
clips using the 
keyboard.
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	● Shift+Option+O. Plays from the current playhead (skimmer) position 
to the end of the selected region or timeline.

	● Shift+Cmd+F. Displays and plays the timeline full screen. (Press Esc 
to exit.)

	● Cmd+L. Toggles playback looping on or off. When enabled, this jumps 
the playhead from the end of a clip or selected range back to the begin-
ning. You won’t see the effect of this shortcut until playback resumes.

	 Snapping—the Secret to Precision
This “snaps” the playhead (skimmer) to an In or a marker.

You enable snapping (shortcut: N), which is off by default, by clicking the 
Snapping icon in the top-right corner of the timeline (see 4 in FIGURE 4.1). 
When enabled, it “snaps” the playhead, or skimmer, to the In at any edit 
point, the In or Out of any marked range, or the location of any marker.

Snapping works in both the Browser and the timeline. It ensures that the 
playhead is correctly positioned at the In of a timeline clip when doing an 
insert or overwrite edit.

1 2 3 4 5 6 7

FIGURE 4.1  Click the Snapping icon 
(4) in the top-right corner of the 
timeline to enable snapping. (See 
Tip 96, Timeline Control Icons, 
for definitions of the rest of these 
controls.)

	 Marking a Clip Sets the In and Out
Marking reduces the time you spend trimming.

To mark a clip means to set an In and/or an Out. This marked area is called 
a range. Clips are marked in the Browser. Move the playhead, or skimmer, 
where you want the clip playback to start, and press I. Then, move the play-
head (skimmer) where you want playback to end, and press O. If no In is set, 
FCP defaults to the start of the clip. If no Out is set, FCP defaults to the end of 
the clip.

Final Cut indicates this area, called a range, in the Browser by surrounding 
it with a gold box; see FIGURE 4.2. That gold box does not indicate the image 
you are editing; rather, it indicates the duration of the clip you are editing 
into the timeline. 
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Snapping works 
even if the Position 
tool is active.
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NOTE  Make selections 
“on the fly” while playing 
Browser clips by pressing 
I or O at the desired point 
during playback.

160  Chapter 4:  Basic Editing



You can also select a range in a Browser clip by dragging across 
the clip with the Select (arrow) or Range tools. If the clip extends 
to a second row, either drag across the break or extend it by Shift-
clicking. Option-drag to replace an existing range with a new range.

Here are some other useful shortcuts:

	● X. Select the entire clip.
	● Option+X. Remove the marked range.
	● Shift+I. Jump the playhead to the In.
	● Shift+O. Jump the playhead to the Out.
	● Click-drag one of the yellow vertical lines to adjust the In 

or Out.

GOING FURTHER  When you mark a range using a keyword (see Tip 175: 
Keywords Allow More Flexible Organization) or a Favorite (see Tip 169, Use 
Favorites to Flag Shots You Like), the Browser clip containing it displays a blue 
(keyword) or green (Favorite) bar at the top of the clip thumbnail. Click the bar 
and, Ta-dah!, the range is instantly marked with an In and an Out.

	 Select Multiple Ranges in One Clip
You don’t need to create just one range at a time.

A range is that part of a clip with an In and/or an Out. Although it 
is normal to use multiple ranges from the same clip, Final Cut has a 
unique feature: You can select more than one range in a clip at the 
same time, provided the ranges don’t overlap.

	● To create a single range, drag the playhead, or skimmer, across 
a Browser clip.

	● To create multiple ranges, create the first range either using 
the Range tool or entering an In and Out. Then Cmd-drag to 
select additional ranges in the same clip; see FIGURE 4.3.

	● To select a single range, click a range.
	● To select multiple ranges in one clip or across several clips, 

Cmd-click.
	● To deselect a selected range, Cmd-click it.
	● To delete a selected range, Option-click it.

GOING FURTHER  You can edit multiple sections of the same clip into the timeline simply 
by editing each one individually. What makes this tip special is the ability to select mul-
tiple ranges in the same clip at the same time; then edit them as a group into the timeline.
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FIGURE 4.3  (top) Multiple selected 
ranges in a single clip. The lower clip 
has no ranges in it. 

FIGURE 4.2  A selected range (top) for 
a Browser clip. The numbers in the 
box indicate its duration. 
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	 Browser Clip Icons
Here’s what these strange clip icons mean.

Once you mark a clip, new icons appear in the corners of clips; see 
FIGURE 4.4. These frame markers are visible in the Browser and Viewer 
when the playhead (skimmer) lands on the appropriate frame. None of these 
icons export. 

Here’s what they mean.

FIGURE 4.4  The playhead is 
parked on the In (top) or Out 
(bottom) of a Browser clip. 

The playhead is parked on 
the In (top) or Out (bottom) 
of a timeline clip. 

The playhead is parked on 
the first frame of the timeline 
(top), the last frame of the 
timeline (middle), or past the 
end of the timeline (bottom). 

EDIT CLIPS
Once clips are marked, editing determines their order in the timeline. 

	 The Magnetic Timeline Is Not Evil!
It’s incredibly helpful—once you learn what it does.

Nothing has been so vilified in Final Cut Pro as the magnetic timeline. 
But once you understand it, it becomes an amazing tool. Prior to Final Cut 
Pro (X), a big problem in all video editing systems was very quick flashes of 
black caused by one to two frame gaps in the timeline. These were impossible 
to see unless you were zoomed way in to the timeline. These were so bother-
some that Final Cut Pro 7 even added a special shortcut to find and remove 
these gaps. 
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The magnetic 
timeline is 
designed to 
prevent problems 
and speed editing.
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Final Cut Pro (X) fixed that. When clips were edited into the Primary Story-
line, which is the black channel in the middle of the timeline, they would 
automatically shift position so that edit points always touched. This made 
editing faster because you no longer needed to perfectly position the play-
head or skimmer before making the edit.

Clips edited to higher layers (Apple prefers not to call these tracks) always 
connect to clips in the Primary Storyline. This speeds editing because if you 
move, say, a talking head clip in the Primary Storyline, all the B-roll and 
sound effects clips connected to it move in sync with it.

These two operational changes make editing a lot faster and more secure 
than on any other NLE. However, as you’ll learn in this chapter, there are 
many techniques that temporarily suspend this magnetic behavior to create 
exactly the edits you have in mind.

	 Final Cut Pro Supports Four Edit Options
Append, insert, overwrite, and connected.

Final Cut supports four types of edits: append, insert, overwrite, and con-
nected. These four edits determine how and where clips are edited from the 
Browser into the timeline.

	● Append (shortcut: E). This places the selected Browser clip, or clips, 
into the Primary Storyline at the end of all existing clips in the time-
line. It ignores the position of the playhead or skimmer. Append edits 
do not alter, move, or replace any existing clips.

	● Insert (shortcut: W). This inserts the selected Browser clip, or clips, 
into the Primary Storyline at the position of the playhead (skimmer) 
and pushes all clips to the right of the edit point downstream for the 
duration of the inserted clip. Insert edits do not alter or replace any 
existing clips.

	● Overwrite (shortcut: D). This edits the selected Browser clip, or clips, 
into the Primary Storyline at the position of the playhead (skimmer) 
and replaces whatever clips are currently in the Primary Storyline for 
the duration of the incoming clip. Overwrite edits do not move any 
existing clips.

	● Connected (shortcut: Q). This places the selected Browser clip, or 
clips, onto the next highest layer above (for video) or below (for audio) 
the Primary Storyline such that no existing clips are replaced, over-
written, or moved.

GOING FURTHER   
The best way to use 
the Primary Storyline 
is to put your principal 
clips in it. These are the 
shots that determine 
the course of a scene. 
For interviews, it’s the 
talking head. For music 
videos, it’s the music 
track. For action, it’s 
the master shot. Every-
thing else, then, con-
nects to this “primary” 
clip. Why? Because, 
by default, clips in 
the Primary Storyline 
can’t change position 
accidentally. 198

The four edit 
options in Final 
Cut Pro are 
append, insert, 
overwrite, and 
connected.

GOING FURTHER   
The Primary Storyline 
supports an unlimited 
number of clips (which 
is somewhat RAM 
dependent) and a maxi-
mum timeline duration 
of 24 hours.
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	 Editing Icons, Tools, and Shortcuts
Yes, you can drag a clip, but these shortcuts are faster!

When it comes time to move a shot from the Browser into the timeline, you 
have three choices:

	● Drag it.
	● Use an editing icon/button.
	● Use a keyboard shortcut.

Dragging works. It’s easy, but it isn’t very precise, and it isn’t very fast.

FIGURE 4.5 illustrates the five editing icons (yup, one is hidden). The numbers 
for the icons correspond with the callout numbers in Figure 4.5:

1.	 Connected edit

2.	 Insert edit

3.	 Append edit

4.	Overwrite edit

5.	 Chevron menu to select between editing 
audio only, video only, or both

The chevron menu remains set until you change it. It doesn’t automatically 
reset.

1 2 3 4 5

FIGURE 4.5  Editing icons: 1. Connected, 
2. Insert, 3. Append, 4. Overwrite, 5. Menu. 

Although these editing icons are helpful to editors who are new to the pro-
gram, my preference is shortcuts. I’m a keyboard junkie. These shortcuts 
mean I can keep one hand on the mouse and the other on the keyboard 
while editing.

	● E. Append edit.
	● W. Insert edit.
	● D. Overwrite edit.
	● Q. Connected edit.
	● Shift+1. Edit clip audio and video.
	● Shift+2. Edit clip audio only.
	● Shift+3. Edit clip video only.
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Dragging a clip is 
easy. Keyboard 
shortcuts are 
much faster.
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	 What’s a Connected Clip?
A connected clip is any clip not in the Primary Storyline.

Either a clip is in the Primary Storyline or it is connected to it. These connec-
tions are visible as light blue dots on top of the Primary Storyline clip repre-
senting the In of the connected clip. There is no limit to the number of clips 
connected to a Primary Storyline clip, nor the number of layers in a project.

The big advantage to connected clips is that they always stay in sync with 
the Primary Storyline clip. This means that if you have B-roll, sound effects, 
or even a music cue connected to a Primary Storyline clip, then decide that 
the Primary Storyline clip would work better elsewhere in the project, simply 
move the Primary Storyline clip. All the clips connected to it tag along with-
out losing sync.

GOING FURTHER  Captions, titles and video clips, along with clips containing both audio 
and video, are located above the Primary Storyline. Audio-only clips are located below 
the Primary Storyline.

	 What’s a Clip Connection?
All clips are connected vertically, but you can move the connection.

All clips not on the Primary Storyline are connected to the Primary 
Storyline clip; see FIGURE 4.6. These clips are called, not surprisingly, 
connected clips. This connection means that if the Primary Storyline 
clip moves, all clips attached to it move as well.

Those connections are indicated by light blue dots at the top of the 
Primary Storyline clip unless the connected clip is selected, in which 
case you see a faint blue line. By default, connections are set to the In 
of the connected clip.

Most of the time, this connection location is fine. Sometimes, though, 
you need to move the connection to a different Primary Storyline clip. 
To do so, press and hold Option+Command then click anywhere inside 
the connected clip. The connection moves to wherever you click.

	 What’s a Storyline?
A storyline is a collection of connected clips and transitions.

Apple has evolved the storyline function since FCP was first released. Now, 
a storyline is a collection of clips and transitions that are treated as a single 
entity; see FIGURE 4.7. A storyline can contain audio or video clips.
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A clip either is 
in the Primary 
Storyline or is 
connected to it.

201

FIGURE 4.6  Clips on layers always 
connect to the clip on the Primary 
Storyline. 
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FIGURE 4.7  Two sepa-
rate connected clips 
(left) and a connected 
storyline (right). The 
connected storyline has 
only one connection 
and a gray bar on top. 
The separate clips each 
have a timeline connec-
tion and no bar on top. 

A connected storyline treats a group of clips as though they were on the 
Primary Storyline:

	● Clip edges touch.
	● Spaces between clips are not allowed, unless inserted as a gap clip.
	● Dragging one clip shuffles other clips.
	● Transitions are supported.

The most common use of storylines is when transitions are added; see Chap-
ter 7, “Transitions & Titles.” However, a connected storyline is used whenever 
you want to group one or more clips. Storylines can group clips only on the 
same layer. (To group clips on multiple layers, use a Compound clip. See 
Tip 245, What’s a Compound Clip?)

	● To create a storyline, select the clips you want to group and choose 
Clip > Create Storyline (shortcut: Cmd+G). If there’s a gap between 
clips, Final Cut adds a gap clip between them.

	● To break apart an existing storyline, choose Clip > Break apart clip 
items (shortcut: Shift+Cmd+G).

	● To move a storyline, drag it by the top bar.
	● To rearrange or trim a clip inside a storyline, select it and drag the clip, 

just like a clip in the Primary Storyline. 
	● To delete a clip from inside a storyline, select it and press Delete.

You’ll find yourself using storylines the most when adding transitions.

	 Move Primary Storyline Clips
Move the clip; leave the connections. This is a grave decision.

Usually, if you delete a Primary Storyline clip, all the clips connected to it are 
deleted as well. (They aren’t actually deleted, but they are removed from the 
timeline.) However, if you have a clip connected to a Primary Storyline clip, 
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it’s possible to move or delete the Primary Storyline clip without changing the 
position of the connected clip around it. 

The trick is to press and hold the grave (`) accent key on your keyboard 
before you do anything. (This is the same key as tilde [~], just below Esc on 
U.S. keyboards.) You’ll see an odd little orange globe icon next to the cursor; 
see FIGURE 4.8. You can now move or remove the Primary Storyline clip from 
under the connected clip without the connected clips moving! All the clips to 
the right then move left to fill the gap. 

GOING FURTHER  The location of the grave/tilde key varies by keyboard language. It is 
located near the Shift key on some international keyboards.

	 Constrain Clip Movement
Press and hold Shift while dragging a clip.

Moving clips by dragging them sideways in the timeline adjusts the timing 
of your story. However, when you drag a clip vertically from one layer to 
another, the one thing you don’t want is for the clip to change its horizontal 
position, because that changes its timing.

So here’s the secret: Press and hold the Shift key while dragging a clip up or 
down in the timeline to prevent it from shifting from side to side. (See, a pun!)

	 Change Clip Durations
If you know what you need, this is faster than dragging.

Most of the time, we change the duration of a clip by dragging an edge; 
this is called trimming. However, there is a faster way, provided you know 
the duration you need. Good uses for this are changing the duration of a 

FIGURE 4.8  Pressing the 
grave (`) key while drag-
ging moves a Primary 
Storyline clip without mov-
ing the clips attached to it. 
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transition, title, or still image. You can also use this to change the duration of 
several selected timeline clips. Here’s how:

1.	 Select the elements you want to change.

2.	 Press Control+D. This switches the Timecode field under the Viewer to 
Duration mode.

3.	 Enter the duration you want—without using punctuation—then press 
Return.

This shortcut can change multiple selected clips at once, with each clip hav-
ing the same duration. If a clip lacks sufficient duration, Final Cut extends the 
Out to the end of the clip but doesn’t change clip speed or invent new media.

Final Cut automatically calculates the correct duration based upon the frame 
rate of the project and adjusts the duration of the element accordingly. I use 
this technique frequently in every project I edit, especially for transitions.

GOING FURTHER  Final Cut adds punctuation and does the math for you. For example, 
based on a 30 fps project:

•	 You type 30 and Final Cut enters 1:00.

•	 You type 120 and Final Cut enters 4:00.

•	 You type 45 and Final Cut enters 1:15.

•	 You type 123456 and Final Cut enters 12:36:08.

	 Use Three-Point Edits for Greater Precision
These edits are designed for speed and precision.

There are two general philosophies about how to edit a clip into the timeline:

	● Drag the clip to the timeline, then figure out what to do with it.
	● Figure out what to do with the clip, then edit it to the timeline.

Ultimately, they probably take the same amount of time; it just depends upon 
where you want to do your thinking. This tip falls into the second philosophi-
cal camp.

A three-point edit is when the duration of a range in the Timeline determines 
where an edited clip from the Browser will begin and end. These are used in 
an already edited project where you need to insert a shot, without changing 
the duration of the overall sequence. These edits provide both precision and 
speed. Here’s how it works:

1.	 Set an In for a clip in the Browser.
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A three-point 
edit precisely 
controls where 
an edited clip 
starts and ends 
without changing 
the duration of 
the project. 
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2.	 Use the Range tool to set an In and Out in the timeline. (You can’t just 
select a clip.)

3.	 Press D to perform an overwrite edit. 

This edits the Browser clip into the selected range in the timeline, 
matching the In of the Browser clip to the In of the timeline range, then 
replacing the remainder of the timeline range with the Browser clip.

4.	 Press Q to perform the same edit, but place the new clip on a higher 
layer.

The benefit to a three-point edit is precision. You can precisely control where 
an edited clip starts and ends without changing the duration of the project. 

	 Create a Back-Time Edit
Back-time edits emphasize the end of a clip.

Back-time edits are a variation of the three-point edit. They are used when 
you care more about where a clip ends than where it starts. Sports is the clas-
sic example. You want to see the runner crossing the finish line more than 
where they started. 

In technical terms, a back-time edit is one where the Out of the clip in the 
Browser is matched to the Out of a range in the timeline. Then Final Cut auto-
matically calculates where to place the In. It doesn’t play the clip backward; 
it simply determines the edit from the Out, rather than the In. Here’s how:

	● Set an Out in a clip in the Browser.
	● Set an Out in the timeline, or use the Range tool to set both the In 

and Out.
	● Press Shift+D to back-time edit the clip into the timeline.

Or—press Shift+Q to back-time edit the clip to a higher layer.

	 Replace Edits Replace a Timeline Clip
Final Cut supports three variations of replace edits.

Yesterday, you edited a clip into the timeline. Today, you realize it’s the right 
duration but the wrong clip. Replace edit to the rescue. A replace edit always 
replaces a clip in the timeline with a clip from the Browser. You can’t replace 
a timeline clip with another timeline clip. 

To create a replace edit, you don’t need to select the timeline clip. Mark 
(set an In and Out) in the Browser clip, then drag it on top of the timeline 
clip you want to replace. A menu pops up (see FIGURE 4.9), displaying the 
Replace options. 

GOING FURTHER   
This edit will fail if the 
Browser clip is not 
long enough to fill 
the timeline duration. 
Also, there’s no need 
to create an edit using 
four points. If there’s 
an In and an Out in 
the timeline, Final Cut 
ignores any Out in the 
Browser. 
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GOING FURTHER   
Whenever you set an 
Out in the timeline, 
you always set a range. 
When the edit is per-
formed, the duration 
of the timeline range 
determines the dura-
tion of the Browser 
clip. The Browser In is 
ignored. This edit will 
fail if the Browser clip 
is not long enough to 
fill the range in the 
timeline. In that case, 
shorten the duration of 
the timeline range.

208
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	● Replace. This replaces the timeline clip with the Browser clip 
and uses the duration of the Browser clip (shortcut: Shift+R).

	● Replace from Start. This replaces the timeline clip with the 
Browser clip and uses the duration of the timeline clip (shortcut: 
Option+R).

	● Replace from End. This replaces the timeline clip with the 
Browser clip by editing the Out of the Browser clip to the Out of 
the timeline clip, then using the duration of the timeline clip to 
set the In of the Browser clip. This is basically a back-time edit, 
except it replaces the timeline clip. (A shortcut is available, but 
not assigned to a key.)

FIGURE 4.9  The five options for a 
replace edit. Drag a Browser clip 
on top of a timeline clip to display 
this list.

	● Replace with Retime to Fit. This is discussed in Tip 210, When to Use 
Replace with Retime to Fit.

	● Replace and Add to Audition. This is discussed in Chapter 5, 
“Advanced Editing.” See Tip 244, Create Auditions in the Timeline.

	 Use a Replace Edit to Replace Audio
Find and fix missing audio in less than a second.

You edited a clip into your project yesterday only to realize that you acciden-
tally deleted the audio. Suddenly you really, really need that audio today. In 
this case, Undo won’t work. The mistake happened too long ago. Replace edit 
to the rescue.

Here’s a fast way to fix the missing audio problem:

1.	 Put the playhead (skimmer) anywhere in the timeline clip you want to 
fix. Don’t even select the clip.

2.	 Press Shift+F. 

This creates a match frame of the timeline clip in the Browser.

3.	 Press Shift+1. 

This makes sure you are editing both audio and video into the timeline.

Once you press Shift+1, you don’t need to press it again. Final Cut 
leaves this setting unchanged from one edit to the next.

4.	 Press Option+R. 

This replaces the timeline clip with the clip in the Browser, but 
matches the duration of the Timeline clip.

You can replace missing audio in less than half a second! 
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A replace edit is 
a blindingly fast 
way to replace 
accidentally 
deleted audio.
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	 When to Use Replace with Retime to Fit
Fit-to-fill edits always change the speed of the incoming clip.

A variation on the replace edit is the Replace with Retime to Fit option, 
also called a fit-to-fill edit. This is used to create a speed effect or if 
the B-roll clip is too short to fill the timeline clip. This is similar to the 
Replace from Start option, but it requires a duration for the Browser 
clip. Unlike the three replace edits discussed in Tip 208, Replace Edits 
Replace a Timeline Clip, this changes the speed of the Browser clip so 
that the duration of the new clip matches the duration of the original 
timeline clip.

1.	 Set an In and Out for the Browser clip you want to use. The dura-
tion is important.

2.	 Drag the Browser clip on top of the timeline clip you want to 
replace; see FIGURE 4.10. (A shortcut is available, but not assigned to 
any key.)

3.	 In the menu, select Replace with Retime to Fit. 

Final Cut changes the speed of the Browser clip to precisely match the dura-
tion of the timeline clip. The Retime to Fit option always changes the new 
clip’s speed.

	 Markers
Markers are the yellow sticky notes of video editing.

I love markers; see FIGURE 4.11. These cheerful little flags scat-
tered throughout a project serve as navigational beacons, a list of 
tasks to do or that are done, even chapter markers for QuickTime 
movies and DVDs. Whether you create markers in the timeline or 
Browser, the process is the same.

	● To create a marker, put the playhead (skimmer) where you 
want it, and press M. 

	● To modify a marker, double-click the marker icon to open 
the Marker dialog.

	● To move a marker, right-click it and choose Edit > Cut. Move 
the playhead (skimmer) to the new location, and choose Edit > Paste.

Or—place the playhead (skimmer) on the marker and press  
Control+, [comma] or . [period] to move the marker left or right one 
frame at a time.
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FIGURE 4.10  Drag a Browser clip 
on top of a timeline clip to reveal 
this menu. 

GOING FURTHER   
The orange or blue 
bar that appears in the 
timeline over the new 
clip is called the Retime 
Editor. See Tip 504, The 
Retime Editor. Press 
Cmd+R to make the bar 
disappear.
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1 2 3 4

FIGURE 4.11  The four marker types: 
1. Marker, 2. Chapter, 3. To-do,  
4. Completed to-do.  
(Jewelry image ©2022  
EmilyHewittPhotography.com)
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	● To jump the playhead to a marker, press Control+; [semicolon] or 
Control+’ [apostrophe].

	● To delete a marker, either double-click it and click the Delete button in 
the Marker dialog or right-click it and select Delete from the menu.

When you modify a marker, the Marker dialog appears; see FIGURE 4.12.

1 2 3

FIGURE 4.12  The 
Marker dialog. The 
top buttons create a: 
1. Marker, 2. To-do 
marker, and 3.  
Chapter marker. 
(Jewelry image ©2022  
EmilyHewitt 
Photography.com)

	 Create Chapter Markers
Chapter markers are great for QuickTime navigation, not just DVDs.

I use chapter markers in many of my QuickTime and MP4 movies; see Fig-
ure 4.12. They create little navigational thumbnails used in QuickTime 
Player, and other video players, to jump to a specific scene in a movie. You 
don’t need to create DVDs to use chapter markers. 

1.	 If a marker already exists, double-click it to open the Marker 
dialog box.

Otherwise, put the playhead (skimmer) where you want it, and press M.

2.	 Press M a second time to open the Marker dialog box.

3.	 Click the far-right icon (3 in Figure 4.12) to create a chapter marker.

Chapter markers generally display a poster frame in the video player. That 
round orange dot (see FIGURE 4.13) selects the frame used for the poster 
frame. It is located 16 frames after the marker to avoid displaying the middle 
of a dissolve as the poster frame. To choose a different frame, drag the round 
dot to the frame you want to use, which need not be in the same clip.

FIGURE 4.13  The orange marker 
is a chapter marker. The round 
orange dot selects the poster 
frame for that marker. Drag the 
dot to change the frame. 
(Jewelry image ©2022  
EmilyHewittPhotography.com)

GOING FURTHER   
Markers are attached 
to the clip, not the 
timeline. If you do 
a replace edit, the 
markers attached to 
the original clip are 
removed. There’s no 
way to attach a marker 
to the timeline.
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NOTE  Although Final Cut 
supports picking a chapter 
poster frame, QuickTime 
Player ignores it. Instead, 
it displays the frame 
under the marker.

GOING FURTHER   
A shortcut to add a 
chapter marker exists 
but is not assigned to 
any key.
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	 Gaps and Timeline Placeholders
Gaps and placeholders have a variety of uses.

A gap is a clip that is opaque and solid black, with a default duration of two 
seconds, though the duration can vary as much as you want. I use gaps to 
separate scenes, to add a short pause, or simply as an indicator that some-
thing is missing. To add a gap, choose Edit > Insert Generator > Gap (shortcut: 
Option+W). This inserts a two-second gap clip at the position of the playhead 
(skimmer). You can adjust the duration of a gap the same as any other clip.

Placeholders are similar to gaps in that they are variable duration clips edited 
into the timeline but used to simulate missing shots. The content of the place-
holder is adjusted in the Inspector.

	● To add a new placeholder, choose Edit > Insert Generator > Placeholder 
(shortcut: Option+Cmd+W). 

	● To modify an existing timeline placeholder, select the clip in the time-
line. Click the Generator icon (red arrow) at the top of the Inspector; see 
FIGURE 4.14. In the panel that appears, select the objects you want to 
appear in the placeholder.

	 Find Duplicated Media
This is a fast way to find shots used more than once.

Apple recently added a feature that quickly finds duplicated media 
in a project. Apple calls these duplicated ranges. This feature is off 
by default. To display media used more than once in a project:

1.	 Open the Clip Appearance button in the top-right corner of 
the timeline (see FIGURE 4.15), and select the Duplicate Ranges 
checkbox.

Clips that use the same media are flagged in the timeline with 
hash marks at the top of the clip; see FIGURE 4.16. 
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GOING FURTHER   
These placeholders 
aren’t true storyboard 
tools. For example, you 
can’t move the people 
inside them. But they 
are useful in visu-
ally thinking through 
missing shots and basic 
composition.

FIGURE 4.14  Placeholder 
content options in the 
Generator Inspector.
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FIGURE 4.15  Display duplicated media 
using the Clip Appearance menu. 
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2.	 Open the Timeline Index, click the chevron (red arrow), and choose 
Show Clips with Duplicated Ranges; see FIGURE 4.17.

Selecting a clip in the Timeline Index selects it in the timeline and moves the 
playhead to the In of that clip.

FIGURE 4.16  Clips that share the same media are indicated 
with hash marks (above). 

FIGURE 4.17  The Timeline Index shows clips that share media. 
When you select a clip, other clips sharing its media are high-
lighted in blue (right). 

EDITING TOOLS
Editing tools are used to select, modify, trim, or move timeline clips. 

	 The Tools Palette
These are the tools you’ll need for editing and trimming.

This toolset, like most, is hidden. Click the arrow icon with the chevron at the 
top of the timeline to reveal it; see FIGURE 4.18. 

	● Select (shortcut: A). (We often call this the Arrow tool.) A general-
purpose tool for moving and selecting stuff.

	● Trim (shortcut: T). Used for roll and slip trimming.
	● Position (shortcut: P). Turns off the magnetic timeline to move clips 

independently.
	● Range Selection (shortcut: R). Sets an In and/or Out range in the 

timeline or Browser. This is a specialized form of the Select tool.
	● Blade (shortcut: B). Cuts clips.
	● Zoom (shortcut: Z). Zooms in to or out of the timeline.
	● Hand (shortcut: H). Moves the timeline without moving any clips.
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FIGURE 4.18  Click the 
chevron to reveal the 
timeline Tools palette. 
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	 The Power of the Position Tool
The Position tool disables the magnetic timeline.

The Position tool (shortcut: P), see FIGURE 4.19, moves any clip anywhere, 
even leaving gaps, by disabling the magnetic properties of the timeline. 
Essentially, when the Position tool is active, Final Cut edits like every other 
nonlinear editor.

	● When you drag a clip, the clip doesn’t spring back. Instead, a clip of 
black video, called a gap, is inserted between the end of the previous 
clip and the one you are moving.

	● When you trim clips, it leaves a gap.
	● When you drag one clip on top of another, the edge of the new clip 

overwrites the old clip.
	● When you move a clip, any open space created is filled with a gap.

The Position tool provides a choice on how our clips behave when we move 
them; enabling the magnetic timeline or turning it off.

	 The Range Tool Doesn’t Select Anything
The Range tool sets an In and Out in the timeline or Browser.

The Range tool (shortcut: R), see FIGURE 4.20, is a specialized form of the 
Select tool. All it does is set an In and Out in the timeline or Browser. Select 
the Range tool from the Tools palette.

The Range tool is used in the Browser but, more commonly, in the timeline. 
(The timeline allows only one In and Out at a time.) While you can use I and 
O to set the In and Out, the Range tool is simpler—you just drag.

An In and Out is not the same as a selection. Timeline ranges are as small as 
a few frames in the middle of a clip or span multiple clips. Ranges generally 
don’t end at the edges of a clip, though they can; see FIGURE 4.21. Ranges are 
used for the following:

	● Exporting a portion of the timeline
	● Adjusting audio levels within the range
	● Adjusting keyframes within the range
	● Creating three-point and back-time edits
	● Deleting portions of a clip, or a section of the 

timeline that doesn’t include entire clips

To remove a range selection, click outside the yellow 
range bounding box with the Arrow tool.
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FIGURE 4.19  The Position 
tool overrides the magnetic 
timeline. 

GOING FURTHER   
To temporarily switch 
to the Position tool, 
press and hold P. 
When you let go, Final 
Cut reverts to the 
previous tool.217

FIGURE 4.20  The Range 
tool sets Ins and Outs. 

FIGURE 4.21  A timeline range spanning two clips. 
Note the adjustment handles on the In and Out. 
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GOING FURTHER  To temporarily switch to the Range tool, press and hold R. Then, draw 
the range. When you let go, Final Cut reverts to the previous tool. However, we can’t move 
an existing range by dragging it or using keyboard shortcuts.

	 Cut Clips with the Blade Tool
Both the Blade tool and shortcuts work, but they work differently.

The Blade tool (shortcut: B), see FIGURE 4.22, cuts clips. So does Cmd+B.  
But they cut clips differently.

Select the Blade tool from the Tools palette. The Blade tool cuts single clips 
anywhere, whether the clip is selected or not. If you press Shift, the Blade 
tool cuts all clips—including captions—where you click.

Cmd+B cuts one or more clips but only at the position of the playhead 
(skimmer). 

	● If no clips are selected, Cmd+B cuts the Primary Storyline clip.
	● If some or all clips are selected, it cuts only selected clips.
	● If a selected clip is disabled (V), it cuts the clip anyway.

The Blade tool is more flexible in terms of where it cuts. Cmd+B is more effi-
cient and selective by cutting only selected clips at the position of the play-
head (skimmer).

GOING FURTHER  A fast way to select the Blade tool is to press and hold B. Cut the clip, 
then let go. Final Cut reverts to the last tool you were using. The Blade tool cuts captions; 
Cmd+B does not, unless the caption is selected.

	 The Zoom Tool
This is a faster way to change the scale of the timeline.

The Zoom tool (shortcut: Z), see FIGURE 4.23, changes the scale of the time-
line, without affecting any clips.

	● To zoom in, select the Zoom tool and click in the timeline.
	● To zoom in to a specific section of the timeline, drag the Zoom tool over 

the area you want to view.
	● To zoom out, Option-click the Zoom tool in the timeline.
	● With another tool selected, press and hold Z, then click or drag to 

resize the timeline. Final Cut zooms in; then, when you let go of Z, it 
selects the previous tool.
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FIGURE 4.22  The Blade 
tool cuts clips. 

219

FIGURE 4.23  The Zoom 
tool scales the timeline.

176  Chapter 4:  Basic Editing



GOING FURTHER  These three zoom shortcuts work in both the timeline and the Viewer:

•	 Press Cmd++ [plus] to zoom in.

•	 Press Cmd+- [minus] to zoom out.

•	 Press Shift+Z to fit the timeline, or Viewer, into the window.

	 The Hand Tool
The Hand tool is a mover.

The Hand tool (shortcut: H), see FIGURE 4.24, moves the timeline without 
moving anything in the timeline. It’s the only tool that can’t select or modify 
a clip in some way.

1.	 Select the Hand tool from the Tools palette. 

2.	 Drag it in the timeline. 

The timeline moves, but the clips don’t. 

Even faster:

1.	 Press and hold H.

2.	 Drag to where you want to go, then let go. 

Final Cut switches back to the previous tool.

GOING FURTHER  Another way to move left or right in the timeline is to drag the small 
slider at the very bottom of the timeline. I find the Hand tool much easier to use.

	 The (Hidden) Delete Key
This is especially helpful for laptop keyboards.

Full-size keyboards have two delete keys: the big one labeled Delete and 
the small one labeled Del. The big one deletes text to the left; the small one 
deletes text to the right.

But what if you are using a laptop? The Del key doesn’t exist. That’s where 
the hidden Delete key comes in; see FIGURE 4.25. 

	● Press the Delete key to delete text to the left, as always.
	● Press Fn+Delete to delete text to the right. 

I use this all the time.

GOING FURTHER  Pressing Delete removes the selected clip from the timeline. Fn+Delete 
replaces the selected clip(s) with a gap of the same duration.

220

FIGURE 4.24  The Hand  
tool moves the timeline 
without moving clips. 

221

FIGURE 4.25  The dual-
purpose Delete key on a 
laptop keyboard. 
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	 The Timeline Clip Menu
Just like the Browser and Viewer, the Timeline has a hidden 
menu.

Right-click any timeline clip to reveal its hidden (contextual) menu; 
see FIGURE 4.26. Most of these options involve editing or trimming. 
We’ll cover them in other tips.

TRIM CLIPS
Trimming adjusts where two clips touch. Editing builds the story. 
Trimming makes it perfect. You’ll spend far more time trimming than 
editing; it’s that important.
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FIGURE 4.26  Right-click any 
timeline clip to reveal this  
contextual menu. 

	 Trimming Basics
Here’s how to trim an edit point.

An edit point is where two clips touch. It has three sides: the Out of the out-
going clip, the In of the incoming clip, and both the In and the Out. 

To trim an edit point, do one of the following:

	● Select the Arrow (Select) tool (shortcut: A) and drag either the Out or 
the In; see FIGURE 4.27. This is a ripple trim; because it adjusts one side 
of the edit, its effect ripples through the rest of the timeline.

	● Select the Trim tool (shortcut: T) and drag both the Out and In at the 
edit point. This is called a roll trim; because it adjusts both sides of the 
edit, it rolls the edit point to a new location.

FIGURE 4.27  Trim the Out of 
the outgoing clip by dragging 
with the Arrow tool. 

As you drag, the numbers above the edit point indicate current timecode 
(left) and the amount the selected frame or edit point moves during the trim. 
In addition to dragging, there are several keyboard shortcuts you can use to 
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trim. Put the playhead (skimmer) at the edit point you want to adjust and do 
the following:

	● Press left square bracket to select the Out.
	● Press right square bracket to select the In.
	● Press backslash [\] to select both the In and the Out.
	● Press comma [,] to move the selected edit point one frame left.
	● Press period [.] to move the selected edit point one frame right.
	● Press Shift+, to move the selected edit point ten frames left.
	● Press Shift+. to move the selected edit point ten frames right.

With an edit point selected in the timeline:

1.	 Press + [plus] to switch the timecode display into data-entry mode and 
tell FCP you intend to move the selection to the right. 

Or—press – [minus] to switch the timecode display into data-entry 
mode and tell FCP you intend to move the selection to the left.

2.	 Enter the number of seconds and/or frames you want the selected 
object to move.

3.	 Press Return to apply the shift.

As long as a selected edit point has sufficient handles and is not blocked by 
another nonselected clip, it will instantly move. For example:

	● Type +16 then press Return to move the selection 16 frames to the right.
	● Type –8 then press Return to move the selection 8 frames to the left.

	 Handles Are Essential for Trimming
Handles are extra video at the ends of a clip.

Handles are extra media before the In or after the Out. They are essential for 
trimming and transitions, because if you need to move the In earlier or the 
Out later, you need extra media to do so.

Final Cut alerts you whether the end of a clip (either In or Out) has handles; 
see FIGURE 4.28. If the selected end of a clip is yellow, there are additional 
frames beyond the edit point. If the edge is red, that is the end of the clip. 

GOING FURTHER  However, the yellow bracket does not indicate how much handle there 
is. It might be only one frame. When there is no handle, you can trim a clip shorter, but 
not longer.

GOING FURTHER   
If one or more clips are 
selected in the timeline, 
these shortcuts will 
also move the clips, 
as long as they aren’t 
blocked by another clip.
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FIGURE 4.28  A red bracket 
means no handles. A 
yellow bracket indicates 
handles.
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	 Trim the Top and Tail of a Clip
Sometimes you just need something quick and dirty.

If the deadline were any closer, it would be sitting in your lap. All you need is 
to trim the beginning and end of a timeline clip and export it. There’s no time 
to drag anything. For greatest speed, use the skimmer to hover over the trim 
point. Don’t click anything.

The whole process takes mere seconds from trim to export with exporting 
happening in the background. TABLE 4.1 lists these shortcuts.

TABLE 4.1  Top and tail trimming shortcuts

SHORTCUT WHAT IT DOES

Option+[ Trim the start of a clip to the playhead (skimmer).

Option+] Trim the end of a clip to the playhead (skimmer).

Option+\ Trim the clip to the selected range. (This requires using the Range 
tool to set a range.)

Cmd+E Export the clip to the default destination.

	 The Hidden Precision Editor
The Precision Editor is an incredible teaching tool.

If editing and trimming are new to you, the Precision Editor is an interac-
tive way to learn and develop your trimming skills. To open it, double-click 
any edit point; see FIGURE 4.29. The edit point opens with the outgoing clip 
on top. 

	● To adjust the Out, drag the top edit point (top arrow). This creates a 
ripple trim.

	● To adjust the In, drag the bottom edit point (bottom arrow). This, too, 
creates a ripple trim.

	● To adjust both the In and the Out, drag the gray box control between 
the layers (middle arrow). This creates a roll edit.

	● The darker areas at the end of each clip indicate the amount of han-
dles, or extra video, before the In or after the Out.

	● A selected clip edge that’s yellow means the clip has handles. A red 
edge means no handles. 

	● To exit the Precision Editor, press Esc, or double-click the middle roll 
trim icon (middle arrow).
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This is a great teaching tool to learn what happens during a trim and the 
importance of handles for effective trimming.

FIGURE 4.29  The Precision 
Editor. The Out is selected in 
the top layer. 

	 The Trim Edit Window
Provides feedback on what you are doing in the timeline.

The Trim Edit window appears only if you enable Preferences > Editing > 
Show detailed trimming feedback; see FIGURE 4.30. 

When you grab the edge of a clip with either the Select (Arrow) or Trim tool 
and drag, the Trim Edit window appears; see FIGURE 4.31.

FIGURE 4.31  The Trim Edit window. The Out is on the left; the In 
is on the right. 

FIGURE 4.30  Preferences > Playback. 

The left side of the window shows the Out at the edit point. The right window 
shows the In at the edit point. As you drag the selected portion of the edit 
point, this window shows what’s changing. 

GOING FURTHER   
The limitation to the 
Precision Editor—and 
it’s a big one—is that 
it does not allow trim-
ming audio separately 
from video. So I use this 
as a teaching tool, but 
not for actual editing.

227

Trim Clips  181



If “Show detailed trimming feedback” is not selected in Editing > Prefer-
ences, Final Cut displays only the frame you are adjusting. I prefer seeing 
both windows, which is why I turn this preference on. It is much easier to 
trim using the Trim Edit window. (See Tip 70, Optimize Editing Preferences.)

	 A Super-Fast Trimming Shortcut
This keyboard shortcut is a high-speed trimming tool.

Sometimes, you just want to move the selected edit point somewhere else. 
Quickly.

1.	 Select the side of the edit point you want to move.

2.	 Position the playhead (skimmer) where you want it to go.

3.	 Press Shift+X.

This technique is called an extend edit. The selected edit point jumps to the 
playhead, provided there are sufficient handles on the clip you are trimming 
and that the move is not blocked by another clip. I use this all the time for 
adjusting title durations, roll trims, and adjustment layers.

	 Split Edits: The Workhorse of Editing
Split edit: When audio and video edit points occur at different times.

Without question, to me, the most important trim is a split edit; 
see FIGURE 4.32. This is where the audio and video edit points occur at differ-
ent times. Split edits are generally created in the Primary Storyline.

Tip 305, Split Trims Edit Audio Separately, shows how to do this in detail. I 
mention it here because it is relevant to editing and trimming.

FIGURE 4.32  A split edit with 
the audio edit rolled to the 
right of the video edit. 

	 Enable Clip Skimming
Clip skimming is a fast way to review a timeline clip.

Turn skimming off (S). Put the cursor inside a timeline clip, and drag. 
Nothing happens.

228

Shift+X is the 
fastest way to move 
a selected edit 
point.

229

230

182  Chapter 4:  Basic Editing



Press Option+Cmd+S. Now drag the cursor inside a timeline clip. See how 
quickly you can see the contents of that timeline clip in the Viewer?

Why would you do this? Imagine you have multiple clips stacked vertically 
with an effect that blocks most of those clips (a very typical effect, by the 
way). Clip skimming displays a clip even if it is blocked by another clip on a 
higher layer.

There’s no need to use this technique if you have only one layer of timeline 
clips.

	 How to Use Audio Clip Skimming
Clip skimming enables audio review in high speed.

You first met skimming in Chapter 2, “The Final Cut Pro Interface.” Audio clip 
skimming is a special form of clip skimming. It’s a fast way to review a single 
audio clip, without hearing any other audio clips above or below it. It lets you 
zero in on the sound from a specific clip.

1.	 Choose View > Clip Skimming. 

Or—press Shift+S.

2.	 Drag the cursor across the clip in the timeline you want to hear.

Repeat the same keystrokes to turn clip skimming off.

	 A Slip Trim Optimizes B-Roll
Slip trim: Adjust content without changing location or duration.

Another hidden trimming tool that I can’t live without is the Slip tool. This 
tool adjusts the content of a shot, moving it earlier or later, without altering 
the clip location in the timeline or the clip duration. It’s like a window in a 
wall. You can’t change the size or position of the window, but by shifting 
your position, you can change the view.

1.	 Select the Trim tool (shortcut: T).

2.	 Click in the middle of the clip you want to adjust. 

3.	 Drag left or right.

The Trim Edit window opens up and displays the In of the slipping clip 
on the left and the Out on the right. 

I use this constantly to find the best piece of B-roll that fits a precise duration 
and location. 

I set the timing of a clip during the edit. I adjust the content once it’s in the 
timeline using a slip trim until I find the content that works best for my story.

GOING FURTHER   
The only other way 
to view a lower-layer 
clip that is blocked by 
a higher-layer clip is 
to select all the upper 
clips and press V to 
turn off their visibility. 
To make these clips 
visible, select them and 
press V again.
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GOING FURTHER   
Final Cut shifts the 
pitch of skimmed audio 
so it sounds fast but not 
squeaky.
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Slip trims adjust 
clip content 
without changing 
its location or 
duration.
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THE TIMELINE INDEX
The Timeline Index is unique to Final Cut. It tracks and organizes all ele-
ments in the timeline in searchable lists.

	 The Timeline Index
This is a powerful tool for navigation and organization.

The Timeline Index is unique to Final Cut and a highly powerful tool to orga-
nize all the elements in the timeline. Apple describes it as a list-based view of 
the timeline. I use it constantly to view clips, markers, keywords, titles, and 
roles, as well as select clips and navigate the timeline. As you play a project, 
the playhead in the timeline and the horizontal playhead in the Index move 
in sync.

To open the Index (see FIGURE 4.33), do either of the following:

	● Click the Index button in the upper left of the timeline.
	● Press Shift+Cmd+2.

Here’s what you can do in the Timeline Index:
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FIGURE 4.33  The Timeline Index. Click the 
word “Index” to open. 

	● View a list of all clips in the currently open project, sorted 
chronologically.

	● Click any clip name, or other element, to jump the play-
head to it and display it in the Viewer. 

	● Select one or more clips or other elements in the timeline.
	● Rename a clip—select it, enter a new name, and press 

Return.
	● Search for a clip, title, marker, or other timeline element—

by name or a portion of its name.
	● Delete an element to delete it in the timeline.
	● View and add notes. (However, I find it easier to select the 

clip, then add the note in the Info Inspector; see Tip 171, 
Add Notes to One or More Clips.)

	● View active multicam angles.
	● View, reassign, and edit roles.
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	 Timeline Index: Customization
Modify columns in the Timeline Index like the Browser.

The Timeline Index organizes all the elements in the timeline into a 
list, just like a spreadsheet.

	● To change column widths, drag the dividing lines between 
column headers.

	● To move columns, drag and rearrange column headers.
	● To reveal more columns, right-click a column; see FIGURE 4.34.

This feature is not available for the Roles tab, which doesn’t 
use columns.

	 Timeline Index: Navigation
The Timeline Index is faster than scrolling through the timeline.

The Timeline Index is built for speed and organization. It is a fast way to find 
a clip—audio, video or title—for example, to check spelling or apply an effect.

In FIGURE 4.35, if you look closely along the left edge, you’ll see a faint play-
head (the red arrow points to it). This echoes the movement of the timeline 
playhead, because the Timeline Index is simply the timeline itself, recast as 
a list. 

	● To locate an element, enter text in the search box.
	● To jump to and select a clip, click any line of text.
	● To select a range of clips, Shift-click more than one line of text.
	● To select any clips you click, Cmd-click more than one line of text.
	● To delete clips, select a line, or a group of lines, and press Delete.

Once something is selected, it is easy to add an effect, move the group, or 
delete it.

	 Timeline Index: Clips
Find, sort, rename, and navigate clips.

1.	 Open the Timeline Index and click Clips; see FIGURE 4.36. 

2.	 At the bottom, choose to view all clips or filter them into Video, Audio, 
or Titles.
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FIGURE 4.35  Click any line of 
text to move the playhead to 
that element and select it. 
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FIGURE 4.34  Right-click a column 
header to reveal hidden Timeline 
Index columns. 
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I find the Titles option very helpful at the end of a project. I can quickly 
jump from one title to the next to verify format and spelling. This high-speed 
review is far faster than scrolling through the timeline and hoping that I spot 
them all.

FIGURE 4.36  The Clips panel 
in the Timeline Index with 
audio clips selected. 

	 Timeline Index: Tags
This is the most useful section of the Timeline Index.

The Tags portion of the Timeline Index (see FIGURE 4.37) is the most useful to 
me. (Roles are second.) This displays all markers and keywords. The follow-
ing numbered list corresponds to the number callouts in Figure 4.37:

1.	 All tags

2.	 All standard (blue) markers

3.	 All keywords

4.	All keywords created though analysis  
(for example, Find People)

5.	 To-do markers

6.	Completed To-do markers

7.	 Chapter markers

All my videos include chapter markers for navigation. Similar to titles, I 
use this panel to find and review each marker before final export. Also, in 
Tip 240, Timeline Index: Markers, I’ll show how to use to-do markers to create 
an editing checklist for your project.

1 2 3 4 5 6 7

FIGURE 4.37  1. All tags, 2. 
Blue markers, 3. Keywords, 4. 
Analysis keywords, 5. To-do 
markers, 6. Completed mark-
ers, and 7. Chapter markers. 

GOING FURTHER   
Changing the text of 
a title in the Timeline 
Index changes only its 
name; it doesn’t change 
the content in the title 
itself. That requires 
selecting and changing 
the text clip itself. Also, 
you can’t spell-check 
titles using the Time-
line Index.
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	 Timeline Index: Roles
Roles are incredibly useful for audio, but they are not 
easy to understand.

When Apple introduced roles to Final Cut, I found them intimi-
dating and alien. But in the years since, I spent time learning 
how to use them, and now, they are part of almost all my proj-
ects. The Timeline Index simplifies using roles; see FIGURE 4.38. 
Chapter 6, “Audio,” provides details on how to use roles. 

As an example, I use roles every week when editing my webi-
nars. I do the edit in Final Cut, then send the audio to Adobe 
Audition for audio cleanup and sweetening. That mixed audio is 
exported as a stereo pair and imported back into Final Cut with 
a Final Mix role assigned to it. Using this section of the Timeline 
Index, I can disable all dialogue and effects clips and enable the 
final mix with one mouse click. No messing with layers or indi-
vidual clips. Works great.

	 Timeline Index: Captions
Use the Timeline Index to find and edit captions.

The Timeline Index is extremely useful when finding and 
reviewing every caption in a project; see FIGURE 4.39. In 
operation, it works the same as the Clips panel. 

What I really like about this panel, though, is the ability to 
double-click a caption to open it for editing in the timeline. 
This is something you can’t do for titles, though you can do 
it for markers. However, you can’t use the Timeline Index 
to change the timing of a caption. Caption durations are 
changed only in the timeline.
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FIGURE 4.38  The Roles panel in the Time-
line Index. 
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FIGURE 4.39  The Caption panel in the Time-
line Index. 
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	 Timeline Index: Markers
Here are some additional tricks you can do with markers.

Although you can’t copy and paste markers from the Timeline Index  
(see FIGURE 4.40), here are some things you can do:

	● Select one or more markers and delete them.
	● Display markers by category: Chapter, Standard, To-do, and Completed.
	● Double-click a marker to open it for editing.
	● Add a note to a marker, which is different from its text.

You can even build an editing checklist in the timeline, then display it in the 
Timeline Index; see FIGURE 4.41. To see To-dos, click the icon indicated by the 
left red arrow. Click the icon to the right of it to see all completed To-dos.

Click the icon to the left of a To-Do marker in the Timeline Index to mark it as 
completed.

FIGURE 4.40  Four different markers 
and their icons (top to bottom): Chapter, 
Standard, To-Do, and Completed To-Do. 
Note the horizontal playhead below 
Scene 2.

FIGURE 4.41  Use the Timeline Index to build a To-do List. 
Select between To-do (left arrow) or completed To-do 
items (right arrow).

GOING FURTHER  To see a specific marker type, click one of the buttons at the bottom of 
this panel, see Tip 237, Timeline Index: Tags.
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CHAPTER 4—BASIC EDITING SHORTCUTS
CATEGORY SHORTCUT WHAT IT DOES

Marking I
Shift+I
Option+I
O
Shift+O
Option+O
X
Option+X

Set an In at the playhead (skimmer)
Jump playhead to the In
Delete the In
Set an Out at the playhead (skimmer)
Jump playhead to the Out
Delete the Out
Set In and Out for entire clip
Delete both In and Out

Editing E
W
D
Q
Cmd+V
Option+V
Option+Cmd+Up arrow
Option+Cmd+Down arrow
Cmd+G
Shift+R
Option+R
Option+W
Cmd+B 

M
Option+M
Control+[Comma/Period]

Append selected clip to end of timeline
Insert selected clip at playhead (skimmer)
Overwrite selected clip at playhead (skimmer)
Edit selected clip at playhead (skimmer) on higher layer
Paste clip into Primary Storyline at playhead (skimmer)
Paste clip into layer above Primary Storyline at playhead (skimmer)
Lift the selected clip in the Primary Storyline to a higher layer
Overwrite selected connected clip into Primary Storyline
Consolidate upper layer clips into a connected storyline
Replace timeline clip with Browser clip, use Browser clip duration
Replace timeline clip with Browser clip, use timeline clip duration
Insert gap at playhead
Cut selected clip(s) at playhead (skimmer), does not cut captions 
unless they are selected
Add marker
Add marker and open marker dialog
Move marker under playhead (skimmer) left/right one frame

Trimming Shift+X
[ - ] - \
[Comma/Period]
Shift+[Comma/Period]
Shift+drag 

Shift+Blade tool

Extend Edit to position of playhead
Select left, right, or both edit points for trimming
Move selected edit point or clip left/right one frame
Move selected edit point or clip left/right ten frames
Constrain the movement, when dragging a timeline clip, to up or 
down only
Cut all timeline clips, including captions, at the position you click

Selection & 
Navigation

S
N
V
Shift+Cmd+2
Control+; / ‘
Cmd+Up arrow
Cmd+Down arrow

Toggle skimming on/off
Toggle snapping on/off
Toggle clip visibility on/off
Display/Hide Timeline Index
Jump playhead to previous/next marker
Select clip on next higher layer in timeline
Select clip on next lower layer in timeline
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CHAPTER WRAP
Well, that was intense. This chapter covered the basics of editing and trim-
ming. In the next chapter, we’ll head into weeds looking at advanced editing 
and trimming techniques in Final Cut Pro.
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Audio Inspector, 248–249, 260
audio levels, 255–260

absolute vs. relative, 257–258
keyboard shortcuts for, 259, 282
keyframes for changing, 

259–260
meters displaying, 255–256
Range tool for, 258, 260
setting for final mix, 274–275
Volume slider for, 261
ways of setting, 257

audio meters, 255–256
audio mixing, 231, 273–275

setting audio levels for, 274–275
speakers vs. headphones 

for, 233
surround sound and, 267

audio monitor, 64
Auditions, 192

creating, 194, 195
previewing clips using, 194–195

automatic dialogue replacement 
(ADR), 254

automatic saving/backups, 94

B
background activities, 392
Background Tasks window, 56–57
backgrounds generator, 311–312
back-time edits, 169
backups

changing location of, 95–96
library database and media, 94
restoring from, 94–95

badges, Browser, 70
Balance Color option, 378
batch renaming, 150
Bayer pattern, 14
Better quality option, 398
bit depth

audio, 232
video, 24–25

Black & White effect, 359
Blade tool, 176
blend modes, 325

multicam clips and, 205–206
recording voice-over, 240–241
roles assigned to, 132, 187, 

267–273
sample rate for, 232
terminology related to, 230–231
timeline used for, 236, 242
waveform display, 68–69, 

233–234
Audio Animation bar, 276
audio channels, 230

accessing in multicam clips, 
214–215

displaying components and, 
249–250

options for configuring, 248
audio clips, 230

breaking apart, 244
editing, 241–255
enhancing, 264–266
levels adjustments, 255–259
panning, 261–262
retiming, 254–255
skimming, 183, 253
split edits for, 246
syncing, 237–240, 244–245
transitions between, 250–253
trimming, 242–243, 245–248

audio components, 230, 249–250
Audio Configuration window, 264
audio effects, 275–281

applying and modifying, 275
creating default, 275
EQ adjustments, 277–279
Limiter effect, 281
pitch adjustments, 277
Space Designer effect, 280
stacking order of, 276
telephone effect, 277

audio fades, 250–253
automatically applying, 

250–251
changing the shape of, 252–253
keyboard shortcut for, 252
manually applying, 251

3D text/titles, 306–309
5.1 surround sound, 249, 256, 267
8-bit, 10-bit, and 12-bit video, 25

A
absolute level, 231, 258
Action Safe zone, 82, 293
Activity Monitor, 96–97
adjustment layer effect, 362–363
Adobe Audition, 187, 400
Adobe Premiere Pro, 211, 338, 402
alpha channels, 86–87, 322
analyzing clips, 347–348
anchor points, 322, 339–340
Angle Assembly menu, 207
Angle Editor

adjusting multicam clips in, 
207–208, 213

changing stacking order in, 
208–209

Angle Viewer, 209–210
angles, multicam, 192
animated titles, 305–306
append edits, 163
Apple TV sidebar, 75
archiving

FCP versions, 97–98
potential issues with, 405
projects using XML, 403, 405

aspect ratios
converting, 154, 193–194
explanation of, 20–21

audio
bit depth of, 232
compound clips and, 198–199
configuration settings, 248–249
displaying meters for, 255–256
expanded vs. detached, 243
exporting, 267
formats and codecs, 5, 7, 234
human hearing and, 232
import settings for, 131–132, 235
iXML files and, 236–237
keyboard shortcuts for, 252, 

259, 282

INDEX
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explanation of, 196
independent, 198
keyboard shortcuts for, 228
markers hidden in, 199
mono audio and, 198–199
organizing clips using, 197
transitions between, 199–200

compressed files, 392
HEVC vs. H.264, 10–11, 399
I-frame vs. Long-GOP, 8–10
reason for using, 4–5

computers
choosing, 27
optimizing, 29–30
stressors on, 28–29

connected clips, 158, 165, 247
connected edits, 163
connection protocols, 34
Consolidate Media option, 107–108
containers or wrappers, 18
contextual menus

Browser clip, 72
timeline clip, 178

continuous playback, 67
Counting generator, 312
Crop & Feather effect, 327
cropping images, 326
crossfades, audio, 231, 250–251
Curves adjustments, 385–387
cut transitions, 285
cutting clips, 176

D
data transfer rates, 36
DCI-P3 color space, 21
decibels (dB), 230, 259
Default workspace, 53
deinterlacing video, 42–43
Delete key, 177
deleting

captions, 218
clips, 70, 140
effects, 275
events, 109
FCP projects, 404
libraries, 104
masks, 364
plug-ins, 93, 357
preferences, 90–91
render files, 137–138
shortcuts, 46

de-mosaicing process, 14
desaturation process, 359

ProRes, 11–13, 395, 398
still image, 6, 7
video, 5, 6–7

collaboration
empty libraries for, 113–114
proxy libraries for, 115

collections
keyword, 145
Smart, 149

color
changing for fonts, 300
chroma subsampling of, 26–27
components of, 221–222
desaturation of, 359
primary and secondary, 

222–223
Color & Effects workspace, 53
Color Board, 380, 381
color correction, 322, 377–389

Balance Color for, 378
Broadcast Safe effect, 388–389
Color Inspector tools for, 

380–386
Digital Color Meter for, 389
keyboard shortcuts for, 390
LUTs used for, 379
Match Color for, 378–379
multicam clips and, 214–215
Pleasantville effect, 386–387
Range Check for, 387, 388
skin tone fix, 383–384
types and rules of, 377

Color Curves, 380, 385
color grading, 14, 322, 377
Color Inspector, 376, 380
Color masks, 365–367
color picker, 301
color space, 21
Color Wheels, 366, 377, 380, 

382–383
Command Editor, 45–46, 47
command sets

creating custom, 44–45
switching between, 46, 47

CommandPost utility, 76
Comparison View, 89–90, 213
components, audio, 230, 249–250
composite images, 322, 325
compound clips, 192, 196–202

applying effects to, 202
creating oversized, 201–202
dynamic nature of, 198
effects requiring, 356

Break Apart Clip Items option, 244
Broadcast Safe effect, 388–389
B-roll, 158, 183, 212
Browser, 50, 66–76

badges displayed in, 70
clip color lines in, 69–70
creating Auditions in, 194
deleted clips in, 70
grouping clips in, 68
hidden menus, 72–73
metadata display, 73–74
search box, 141–142
settings menu, 67
sorting clips in, 67–68
thumbnail edges in, 71
view options, 74
waveform display, 68–69

C
camera source files, 4
captions, 192, 215–220

editing SRT, 219
enabling/disabling, 217
formats supported for, 215–216
importing, 216–217
keyboard shortcuts for, 228
options for modifying, 218
roles created for, 217–218
Timeline Index and, 187
translation tip for, 219–220

cast shadows, 298, 361
CEO-608 caption format, 215–216
channels. See audio channels
chapter markers, 172
Cherry, Tom, 7, 335
chroma key effect, 374–376
chroma subsampling, 26–27
cinematic look, 20
clips

compound, 192, 196–202, 356
connected, 158, 165, 247
downstream/upstream, 158
flattened, 211–212
multicam, 192, 203–215
positions of, 338–339
stacking order of, 208–209, 324
See also audio clips; video clips

closed captions, 192, 215
cloud-based editing, 33–34
codecs, 5–7

audio, 5, 7
export, 395
optimization of, 8
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file name changes, 121–122
Final Cut Pro (FCP)

archive options, 97–98
basic concepts, 2–3
interface, 50–59
names and versions, 2
statistics about, 107
troubleshooting, 90–94
user guide, 50

find function. See searches
Finder

dragging clips from, 123
keyboard shortcuts, 48
tag assignments, 130

finished files, 392
fit-to-fill edits, 171
flagging clips, 139–140
flattened clips, 211–212
flicker reduction, 361
flipping clips, 338
Flow transition, 290–291
folder names, 130
fonts

choosing for text, 293–294
color changes for, 300

foreground activities, 392
formats. See file formats
frame rates

changing, 153–154
checking, 139
cinematic look and, 20
explanation of, 19
matching, 152–153
Zoom video, 154

frames, 9
dropped, 63–64
exporting, 395–396
sizes of, 18–19, 139
trimming audio to, 247–248

G
gaps, 173, 246
Gaussian Blur effect, 357–358
General preferences panel, 60–61
generated media, 3
generators, 284, 310–318

adjusting, 346–347
background, 311–312
element, 312–313
keyboard shortcuts for, 319
modifying default, 315
solid color, 314
texture, 314–315

Effects browser, 50, 351–352
elements generator, 312–313
embedded data, 392
emojis, title/text, 304
empty libraries, 113–114
enhancing audio, 264–266
EQ adjustments, 277–279
Event Viewer, 88–89
events, 3, 109–113

copying and moving, 105, 
110–112

creating, renaming, and 
deleting, 109

organizing libraries using, 110
storing clips in multiple, 

112–113
expanded audio, 243
Export File menu, 394–395
exporting, 392, 393–403

faster vs. better options for, 
398–399

H.264 vs. HEVC compression 
for, 399

high-quality finished files, 395
icon and menu options for, 

393–395
Info tag changes for, 396–397
keyboard shortcuts for, 406
projects for social media, 

397–398
proxy files, 399–400
still frames, 395–396
XML files, 400–403

extend edits, 182
extensions, workflow, 59
external media, 3, 39

F
Facebook exports, 398
FaceTime camera recording, 133
fades

audio, 250–253
visual, 284

Faster encode option, 398, 399
Fat EQ filter, 278
Favorite, Scott, 266
Favorites

flagging clips as, 139–140
import locations as, 128

file formats, 5–7
audio codecs and, 5, 7
still image codecs and, 6, 7
video codecs and, 5, 6–7

Destination preferences panel, 
65–66

detached audio, 243, 245
Digital Color Meter, 389
direct-attached storage, 32
dissolve transitions, 284, 285, 

289–290
Distort effect, 330
distortion, audio, 231
Dock options, 98
double-system audio, 230
downstream clips, 158
dragging clips, 123
Draw masks, 365
drop shadows, 298–299, 318
drop zones, 345–346
dropped frame errors, 63–64
Dual Displays workspace, 53
dual-channel mono, 230, 248, 263
dual-monitor display, 56, 81, 

210, 226
Duplicate Project option, 76
duplicated media, 173–174
duration, changing clip, 167–168

E
edit points

defined, 157, 159, 178
trimming, 178–179

Editing preferences panel, 61–62
editing tools, 174–178

Blade tool, 176
Hand tool, 177
Position tool, 175
Range tool, 175–176
Tools palette, 174
Zoom tool, 176

effects
adjusting, 352
compound clips and, 202
copying to multiple clips, 340
creating default, 355–356
faster application of, 353–354
multicam clips and, 213–214
previewing, 353
removing from clips, 341, 

355, 357
resetting or disabling, 324
stacking order of, 276, 355
tracking, 368–370
See also audio effects; 

visual effects
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L
languages, roles for, 270
layers, 158

adjustment, 362–363
Photoshop, 125–126

levels. See audio levels
libraries, 2–3, 102–115

closing and deleting, 104
collaboration using, 113–115
consolidating media in, 

107–108
copying events into, 105, 

110–111, 129
creating and renaming, 103
empty and proxy, 113–115
exporting contents of, 403
file size information for, 107
Motion templates stored in, 

115–116
moving events between, 112
organizing with events, 110
storage locations for, 106
strategy for using, 102

Library List, 50, 104–105
Library Manager utility, 108
light flicker reduction, 361
Light Wrap option, 376
lighting 3D text, 308–309
Limiter effect, 281
links

icon for broken, 135
relinking broken, 135–136

Log video, 16
Long-GOP compression, 8–10
Look effects, 359
loudness, 230, 266
lower-third, 192
Luma key, 373
luminance, 23, 221, 222
LUTs (lookup tables), 17, 379

M
macOS keyboard shortcuts, 47, 48
magnetic timeline, 162–163
managed media, 3
markers

chapter, 172
compound clips and, 199
Timeline Index and, 188
working with, 171–172

Info Inspector
adding notes in, 141
finding info in, 142
metadata in, 142–143

Info tags, 396–397
insert edits, 163
Inspector, 50, 58
interface, 50–59

icon colors, 57
keyboard shortcuts, 100
main areas, 50–51
modifying, 51–52
second monitor display, 56
workspaces, 53–55

interlaced video, 40–43
deinterlacing, 42–43
progressive video vs., 41–42

internal storage, 32, 39
ITT caption format, 216
iXML audio files, 236–237

J
JPEG files, 7, 396
jump cuts, 290–291

K
Ken Burns effect, 327–329
keyboard shortcuts, 44–47

command sets and, 44–45, 
46, 47

creating custom, 45–46, 55
deleting custom, 46
finding in macOS, 47
terminology used for, 44

keyframes
acceleration controls, 350
adjusting, 344–345
audio, 259–260
easing in/out of, 329
explanation of, 231, 322
navigating, 350–351
video, 341–343

keys, 322, 373–376
chroma, 374–376
Luma, 373

Keyword Shortcuts panel, 144–145
keywords, 144–147

applying to clips, 144–145, 146
collections of, 145–146
creating during import, 130
searching for, 146–147

gradients in text, 300
Graphic Equalizer, 265, 279
grave/tilde key, 167
grayscale values, 192, 220–221
grouping clips, 68

H
H.264 compression, 10–11, 392, 

395, 399
Hand tool, 177
handles, 158, 284

for transitions, 286
for trimming, 179

hard drives, 31
hardware

computer, 29–30
storage, 31–32

HDR media, 22–24
monitoring, 23–24, 121
project creation, 120–121
SDR media vs., 22–23

HEVC compression, 10–11, 392, 399
hiding faces, 358
Histogram, 223, 224, 227
hue, explanation of, 221, 222
Hue/Saturation Curves, 380, 

385–387
Hum Removal option, 266

I
I-frame compression, 8–10
image stabilization, 332
Import preferences panel, 65
importing media, 122–127

audio options for, 131–132, 235
caption files, 216–217
choosing settings for, 128–132
copying to storage before, 122
creating proxies after, 133–134
display options for, 126–127
dragging clips from Finder, 123
favorite locations for, 128
keyboard shortcuts for, 155
layered Photoshop files, 

125–126
Media Import window for, 

123–124, 126–127, 128–132
PDF image quality and, 126
timecode display for, 127

In/Out points, 158
marking clips to set, 160–161
Range tool for setting, 175
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optimization
of codecs, 8
of computers, 29–30
of media, 131, 134

optimized files, 4
Organize workspace, 53
overlays, 83–84
overwrite edits, 163

P
panels, resizing, 52
panning audio, 231, 261–262
PDF files, 126
peak hold indicator, 256
Photos sidebar, 75
Photoshop documents, 125–126
picture-in-picture effect, 335
pitch adjustments, 277
pixelization settings, 358
Placeholder generator, 313
placeholders, timeline, 173
Playback preferences panel, 62–63
playhead, 51, 78
playing clips

multiple ways of, 124–125
shortcuts for, 159–160

Pleasantville effect, 386–387
plug-ins

caption, 220
deleting, 93, 357

PNG files, 7, 126, 396
pointing devices, 30
Position tool, 175
Powles, Michael, 251
PRAM and NVRAM reset, 93–94
Precision Editor, 180–181
preferences, 60–66

Destination, 65–66
Editing, 61–62
General, 60–61
Import, 65
Playback, 62–63

preview monitor, 88–89
previewing

clips, 194–195
effects, 353
titles, 294
transitions, 288

primary colors, 222–223, 322
Primary Storyline, 158

best way to use, 163
connected clips and, 165

Angle Viewer setup for, 
209–210

audio channel access in, 
214–215

bandwidth requirements for, 
38, 204

characteristics of, 203
data storage and, 38–39
editing, 210–211
effects added to, 213–214
flattening of, 211–212
keyboard shortcuts for, 228
labeling, 204–205
modifying edited, 213
multicam angles and, 212
stacking order of, 208–209
syncing, 205–207
trimming, 211

multichannel audio, 263
Murphy’s Law, 2
Music sidebar, 75

N
naming/renaming

clips, 150
events, 109
files, 121–122
folders, 130
libraries, 103
presets for, 150

navigation
keyboard shortcuts, 189
Timeline Index, 185

network-attached storage, 32
Newell, Scott, 30, 71, 203, 214
noise reduction, 360–361
Noise Removal option, 266
notes

adding to clips, 141
searching for, 141, 142

NVRAM and PRAM reset, 93–94

O
object tracking, 367–372

adjusting tracks for, 370–371
effects tracked with, 368–370
linking multiple objects for, 

371–372
moving objects with, 367–368

offline files, 135
opacity adjustments, 325, 349
Open Clip option, 193

marking clips, 160–162
icons related to, 162
keyboard shortcuts for, 189
setting In/Out points by, 

160–161
masks, 363–367

Color, 365–367
Draw, 365
Shape, 363–364

master files, 392
Match Color option, 378–379
measurement options, 60–61
media, 3

finding duplicated, 173–174
importing, 122–127
optimization of, 8, 131, 134
relinking missing, 135–136
suggested storage of, 405
viewing unused, 140–141
See also video media

Media Import window
choosing settings in, 128–132
display options, 126–127
importing media using, 123–124

metadata
changing Info tags and, 

396–397
customizing fields for, 143
displaying in Info Inspector, 

142–143
viewing in Browser, 73–74

missing media
alert for, 93, 135
finding, 148
relinking, 135–136

mixing. See audio mixing
monitor speakers, 233
monitors

audio, 64
HDR media, 23–24, 121
video, 56

mono audio, 131, 230
audio meter for, 256
compound clips and, 198–199
dual-channel, 230, 248, 263
panning, 261–262

motion paths, 322, 343–344
Motion templates, 115–116, 357
Motion tool, 291–292, 309, 362
moving clips, 166–167
MP3 audio files, 235
multicam clips, 192, 203–215

Angle Editor and, 207–209, 213
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noncontiguous clip, 354
note, 141, 142

second monitor, 56, 81, 210, 226
secondary colors, 222–223, 322
SendToX utility, 402
Sepia effect, 360
Shape masks, 363–364
Shapes generator, 313
Share icon, 59, 393
Share menu, 394–395
sharing, 59, 392, 406

See also exporting
shortcuts. See keyboard shortcuts
sidebars

hiding/showing, 152
Sound Effects, 75–76
types of, 75

sidecar data, 392
skimmer, 51, 71, 127
skimming

audio clip, 183, 253
video clip, 182–183

skin tone fix, 383–384
Slip tool, 183
Smart Collections, 149
Smart Conform option, 193–194
snapping, 158, 160
snapshots, project, 118
social media exports, 397–398
Software Update panel, 99
solids generator, 314
solid-state drives (SSDs), 31, 32
sorting clips, 67–68
sound effects, 99
Sound Effects sidebar, 75–76
Space Designer effect, 280
Spatial Conform options, 330–331
speech, improving clarity of, 266
Spill Suppression option, 376
split edits, 182, 246
SRT caption format, 216, 219
stacking order

clip, 208–209, 324
effect, 276, 355

stems, audio, 231
stereo audio, 230, 249, 256
still images

exporting, 395–396
formats and codecs for, 6, 7

storage, 30, 31–40
cloud-based, 33–34
connection protocols, 34
data transfer rates and, 36

recording
FaceTime camera, 133
voice-over, 240–241

Recovery mode, 91
reframing clips, 193–194, 346
Rejected clips, 140
relative level, 231, 258
relinking media files, 135–136
renaming. See naming/renaming
render files

creating, 137
deleting, 137–138

rendering video, 322
replace edits, 169–171

how to use, 169–170
missing audio and, 170
Retime to Fit with, 171

Ress, Carsten, 219, 220
Retime to Fit option, 171
retiming audio, 254–255
reverse stereo, 249
RGB Parade, 223, 224
ripple trim, 159, 178, 288
roles and subroles, 267–273

assigning to clips, 132, 269
audio stems/submixes and, 

272–273
creating for captions, 217–218
explanation of, 267–268
focusing on clips using, 272
keyboard shortcuts for, 269
timeline Index and, 187, 

270–271
roll trim, 159, 178, 288
Rolling Shutter correction, 333
room tone, 231
rotating clips, 337

S
safe zones, 82–83
sample rate, 232
saturation, 221, 222
saving, automatic, 94
scaling images, 322, 331
SDR media, 22–23, 116–117
search box, 141–142
Search Filter dialog, 146–147, 

148, 149
searches

criteria for, 147
icons indicating, 148–149
keyword, 146–147
missing media, 148

moving/removing clips on, 
166–167

trimming audio clips in, 
245–246

progressive video, 41–42
projects, 3, 116–121

archiving using XML, 403, 405
exporting for social media, 

397–398
formatting new, 118–119
frame rates for, 152–154
HDR media, 120–121
managing in timeline, 76–77
modifying existing, 119–120
options for completed, 

404–405
SDR media, 116–117
snapshots created from, 118
timecode burned into, 313

ProRes video codecs
explained, 11–12
exporting files using, 395, 398
raw file format and, 15
recommendations for 

choosing, 13
version descriptions, 12–13
white papers on, 17

proxy files, 4
creating after import, 133–134
enabling in Viewer, 85
exporting, 399
lower image quality of, 400
multicam editing and, 39
reasons for using, 36–38

proxy libraries, 115
PSD files, 7

Q
QuickTime Player, 42

R
RAID storage, 31, 32, 33
Range Check options, 387
Range tool, 175–176, 258, 260
ranges, 158

duplicated, 173
marking, 160–161
selecting multiple, 161
tool for setting, 175

Rate Conform setting, 333–334
raw file format, 14, 15
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Transcode Media button, 134, 135
Transform settings, 334–335
transitions, 284–292

applying, 287
audio clips and, 250–251
changing duration of, 288
compound clips and, 199–200
creating or deleting custom, 

290, 292
dissolve, 284, 285, 289–290
Flow for jump cuts, 290–291
handles required for, 286
keyboard shortcuts for, 319
modifying, 289, 291–292
previewing, 288
resetting default, 290
searching for specific, 287
trimming clips under, 288
types of visual, 284–285
viewing available, 286–287
yellow dots for, 291

Transitions browser, 286–287
translating SRT captions, 219–220
Trim Edit window, 181–182
trimming, 157, 158, 178–183

audio, 242–243
basics of, 178–179
connected audio clips, 247
extend edits for, 182
handles needed for, 179
image cropping and, 326
keyboard shortcuts for, 180, 

182, 189, 228, 282
multicam editing and, 211
Precision Editor for, 180–181
quick top and tail trims, 180
Slip tool for, 183
split edits for, 182, 246
transitions and, 288
Trim Edit window for, 181–182

troubleshooting, 90–94
Final Cut crashes, 92
general techniques for, 90–91
missing media alerts, 93

U
upstream clips, 158

V
van Hurkman, Alexis, 377
Vectorscope, 223, 224, 225–226, 227
Video Animation bar, 348–349

syncing multicam clips 
using, 207

viewing during import, 127
Timecode generator, 313–314
timeline, 50, 76–80

audio display, 236
clip menu, 178
control icons, 78
creating Auditions in, 195
customizing, 151
elements, 159
magnetic, 162–163
managing projects in, 76–77
moving around in, 80
solution for scrolling, 76
stacking order in, 324
switching projects in, 77
timecode displays, 78–80
titles added to, 294–295
zooming in to, 151–152

Timeline Index, 184–188
Captions panel, 187
Clips panel, 185–186
customizing, 185
enabling captions using, 217
features overview, 184
managing markers in, 188
navigation functions, 185
reviewing titles in, 303
Roles panel, 187, 217
search feature, 354
Tags panel, 186

Title Safe zone, 82, 293
titles, 292–310

3D text and, 306–309
adding to timeline, 294
animation of, 305–306
changing default, 302
emojis added to, 304
formatting, 296, 298–299
kerning adjustments, 301–302
keyboard shortcuts for, 302, 

303–304, 319
modifying, 295–296, 309
previewing, 294
quickly reviewing, 303
removing custom, 310
rules for using, 292–293
See also text

Tools palette, 174
trackballs, 30
tracking. See object tracking

determining your need for, 
34–35

external vs. internal, 39
file types related to, 39–40
hardware types for, 31–32
internal, direct-, and 

network‑attached, 32–33
multicam editing and, 38–39
proxy files and, 36–38
specs to consider for, 34

storylines, 158, 165–166
See also Primary Storyline

storytelling, 101, 157, 407
subroles. See roles and subroles
surround sound, 230, 249, 256, 267
syncing, 231

audio clips, 237–240, 244–245
multicam clips, 205–207

T
tags

Finder, 130
Info, 396–397
timeline Index, 186

telephone voice effect, 277
templates

3D text, 306–307
Motion, 115–116, 357

text, 292–310
3D titles and, 306–309
depth added to, 297–298
drop shadows for, 298, 299, 318
font choices for, 293–294
formatting, 296, 298–299
kerning adjustments, 301–302
keyboard shortcuts for, 

303–304, 319
positioning, 296–297
rules for using, 292–293
textures added to, 307–308, 

315–316
video inside, 316–318
See also titles

textures
generator, 314–315
text, 307–308, 315–316

Thompson, Jerry, 76, 215, 235, 273, 
329, 332, 398

three-point edits, 168–169
TIFF files, 7, 396
timecode displays, 78–80

burning into projects, 313
floating windows for, 79–80
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Voice Isolation option, 266
voice-over recording, 240–241
Volume slider, 261

W
Waveform Monitor, 223, 224, 227
waveforms

Browser display of, 68–69
explanation of audio, 230, 

233–234
timeline display of, 236

white balance fix, 378
Wilt, Adam, 379
wipe transitions, 284, 285
workflow extensions, 59
workspaces, 53–55

creating custom, 54–55
prebuilt, 53

wrappers, 18

X
XML files, 392, 400–403

archiving projects using, 403
converting for Adobe apps, 

401–402
reasons for using, 400–401
sending Premiere projects 

using, 402
steps for exporting, 401

XtoCC conversion utility, 401

Y
YouTube exports, 398

Z
Zoom tool, 176
Zoom videos, 154
zooming

shortcuts for, 177
the timeline, 151–152

video media
bit depth of, 24–25
compression of, 4–5
formats and codecs for, 5, 6–7
frame sizes and rates for, 18–19
HDR format for, 22–24
interlaced, 40–43
Log files and, 16
progressive, 41–42
ProRes codecs for, 11–13, 15
raw format for, 14–15
text containing, 316–318
types of, 3–4

video monitor, 56
video scopes, 192, 223–227

Histogram, 223, 224, 227
keyboard shortcuts for, 228
second monitor display, 226
selecting and customizing, 227
Vectorscope, 223, 224, 

225–226, 227
View menu, 226–227
Waveform Monitor, 223, 

224, 227
View menu

Video Scope, 226–227
Viewer, 81, 83

Viewer, 50, 80–88
full screen display, 81
keyframe controls, 350–351
onscreen controls, 336–337
overlay options, 83–84
proxy file options, 85
quality vs. performance 

options, 83
red box appearance, 87–88
rotating clips in, 337
safe zones display, 82–83
transparency options, 86–87
View menu, 81, 83

visual effects, 321–390
color correction/grading, 

376–389
Effects browser and, 351–357
examples of creating, 357–363
keyboard shortcuts for, 390
masks and keys, 363–376
Transform effects, 334–349
Video Inspector effects, 

322–334
Viewer effects, 350–351

video clips
analyzing, 347–348
deleting, 70, 140
flagging, 139–140
marking, 160–162
moving, 166–167
naming/renaming, 150
playing, 124–125, 159–160
previewing, 194–195
reframing, 193–194, 346
rotating and flipping, 337–338
sorting and grouping, 67–68
trimming, 157, 158, 178–183

video editing
back-time edits, 169
cloud-based, 33–34
computer setup for, 27–30
duration changes in, 167–168
extend edits, 182
gaps and placeholders in, 173
icons related to, 164
keyboard shortcuts for, 164, 

189, 228
markers used in, 171–172
multicam, 38–39, 203–215
noise reduction, 360–361
options supported by FCP, 163
proxy files for, 36–38
replace edits, 169–171
split edits, 182
storage for, 31–40
terminology related to, 

158–159, 192
three-point edits, 168–169
tools for, 174–178
types of edits in, 163

Video Inspector, 322–334
adjusting effects in, 352
categories in, 323–324
Compositing settings, 325
Crop or Trim options, 326
Distort effect, 330
image stabilization option, 332
Ken Burns effect, 327–329
Rate Conform setting, 333–334
resetting effects in, 324
Rolling Shutter correction, 333
Spatial Conform options, 

330–331
Transform settings, 334–335
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